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  Hunter librarians continue to offer instruction in the use of library resources to all WCU
faculty and staff. This spring we have scheduled one class each of Good Web Searching
and Online Databases in the library’s electronic classroom. We are also available to
come to your department for group or individual instruction on any subject. Please
do not hesitate to contact us when you have questions about using the library’s online
or print resources.
  The following two hands-on workshops have been scheduled in our electronic class-
room, Hunter 186.

  The Western North Carolina Library Net-
work (WNCLN) has purchased and installed
software making it possible for faculty,
staff and students to use online databases
from off-campus. This is great news for
those of you who like to use the library
resources from home.  You can now access
most of the online full-text databases like
Academic Universe, EBSCOHost, and
ProQuest regardless of your Internet pro-
vider.

  In order to use this new service, you must
be using Netscape 3.00 or above OR
Internet Explorer 3.02 or above. (You can-
not use AOL’s browser software or NetTV.)
You will be required to configure your
browser to use a proxy server. The instruc-

NON-
TRADITIONAL
SOCIAL
 INSECTS?
by Bill Kirwan,

University Librarian

  What are non-tradi-
tional social insects?
Colonies of ants or bees that practice alter-
native life styles?  Hardly.  But they are one
of the principal research interests of James
Costa, Assistant Professor of Biology and
Hunter Scholar for 1999.  He explains that
the scientific work on social insects “is
largely based on studies of ants, bees, wasps
and termites—species characterized by spe-
cialized worker, soldier and reproductive
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by Jill Ellern, Systems Analyst

    To sign up for these workshops or to request individual or departmental
instruction, please call Nan Watkins at 3398 or email her at watkinsn@wcu.edu.
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Good Web Searching
Friday, February 26

at 3:00
Teaches effective ways
to focus and narrow Web
searching to retrieve
good results.

Online Databases
Tuesday, March 2 at 3:00
Gives overview of the many
general and subject-specific
databases available through
Hunter Library’s homepage.
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castes.”  He studies social insects falling outside this traditional framework
such as tent caterpillars and earwigs.

  No single comprehensive treatment of these non-traditional societies has
been written and last year Dr. Costa was offered a book contract by Harvard
University Press to produce such a work.  He commented that, “The Hunter
Scholar Award [will] provide me with the time and resources to focus on



Hunter Library

Statistical informa-
tion on the state of
North Carolina is
available from mul-
tiple state and federal
agencies on the
Internet.  Over the
next few issues we
will be listing re-
sources, some with
Web sites, in various
subject areas on

North Carolina Counties & Cities Statistical
Information
Old North State: State, County, and Local Information - May
15, 1998
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Hunter Scholar

North Carolina Counties
and Cities Statistical In-
formation, compiled by
Alex Hess, Acting Librar-
ian from the Institute of
Government.  For addi-
tional information on
any of these sites or to
suggest a recommenda-
tion for best sites,
please call Nancy
Kolenbrander at 7252.

Elections:
North Carolina Manual, N.C. Dept. of the Secretary of State,
Legislative Office Bldg., 300 N. Salisbury St., Raleigh, NC,
27603-5909
(919-733-4098; Fax 919-733-4092) (issued every two years)
Voter Registration in North Carolina, North Carolina State
Board of Elections
http://www.state.nc.us/SBOE/voterrreg.htm

Employment:
Civilian Labor Force Estimates (Labor Force/Employment/
Unemployment Rates)for NC Counties (Monthly 1990-
1998), Employment Security Commission of North Carolina,
N.C. Dept. of Commerce
http://www.esc.state.nc.us/lmi/laus/clf/selcty2.htm

Civilian Labor Force Estimates (Labor Force/Employment/
Unemployment Rates) for NC Metropolitan Statistical
Areas (Monthly Estimates 1990 - 1998), Employment
Security Commission of North Carolina, N.C. Dept. of Com-
merce
http://www.esc.state.nc.us/lmi/laus/clf/selmsa2.htm

Current Labor Force/Employment/Unemployment Rates for
N.C. Metropolitan Statistical Areas (MSAs) and Counties,
Employment Security Commission of North Carolina, N.C. Dept.
of Commerce
http://www.esc.state.nc.us/news/CTYRates.html

Map of County Unemployment Rates, Employment Security
Commission of North Carolina, N.C. Dept. of Commerce
http://www.esc.state.nc.us/lmi/images/unemprtc.gif

...especially important components of this book
project which rely heavily on computer data-
base and print literature searches.”

  The Hunter Scholar Award is a combined ef-
fort of Hunter Library, the Office of Academic
Affairs and The Office of Research and Gradu-
ate Studies to support faculty research efforts.
It provides a faculty study in the library, sup-
port for literature searching and photocopying,
a graduate assistant and one course release time
each semester for the award year.

Continued from page 1

tions for configuring the proxy server are lo-
cated on the Hunter Library homepage (http:/
/www.wcu.edu/library/) under “Online Re-
sources.”  Click on “Databases available to off-
campus users,” and follow the instructions for
your particular browser.  You will only need to
do this once.  After that, you will be prompted
for your name and ID number—as it is printed
on your Cat Card— once each session or if you
don’t access a database for 10 minutes.
  How does this work:
   When you make a request for a Web page
found on one of the database sites, the library
software makes that site think that you are
on-campus.  It does this by using a piece of
software called a proxy server. The WNCLN’s
proxy server, which resides on the library’s com-
puter on campus, actually requests the page
for you.  The proxy server will then “forward”
the page to your computer.  The proxy server
can only forward pages to library borrowers that
have been validated using the library’s patron
database.  In this way, only folks with valid
library cards can use this service.

Databases Available Off-Campus
Continued from page 1

■
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The Map Room and GIS

■

  GIS is one of the buzzwords of the day. But how many
people really know what GIS stands for and what it does?
The acronym GIS translates into Geographic Information
System.  The geographic component is a mapping pro-
gram that allows you to show on a map the spatial distri-
bution of data, for example the variation in population
density over an area.  The Information System compo-
nent is a database management system that allows you
to manipulate data contained in tables, i.e., .dbf files.
When you put these two components together you have
a powerful spatial analysis system.  It makes it possible
to not only represent the spatial distribution of data on
a map, but it also allows you to manipulate the data in
many different ways and then map the various results.
What took hours to achieve in the past can now be done
in minutes.  But there is a catch, and that catch is the
availability and compatibility of data to be mapped.  A
GIS system allows you to manipulate data, but it does
not create the data for you.  Data collection is the most
labor intensive and costly aspect of GIS.  It is not only
important that the data collected is accurate, but it must
also be georeferenced, the process of tying data to its
spatial location.  This can be in the form of latitude/
longitude readings, street addresses, zip codes, area codes,
etc.  It all depends on how specific you want to be in
locating your data.  A latitude/longitude reading, for ex-
ample, is a more specific location than a zip code.
  Who has need for such powerful spatial analysis capa-
bilities?  Anyone who works with data that has a spatial
component.  The US Fish and Wildlife Service and the US
Forest Service were two of the first agencies to experi-
ment with GIS.  Since then its use has invaded many
areas of our lives.  Public utilities use it to keep up with

by Anita Oser, Map Librarian

their vast networks.  Cities use it for planning urban de-
velopment, maintaining infrastructures, providing police
protection, etc.  Transportation providers, such as UPS
and FedEx, use it to route their cargo.  GIS is also heavily
used in marketing to identify new markets and to iden-
tify the characteristics of these markets.  You can rest
assured that GIS played a role in locating the Wal-Mart in
Sylva.  Or have you ever been the recipient of a survey
call and were asked for your zip code?  Ever wondered
why they wanted to know?  Now you know.  You became
a part of a marketing database for use with a GIS system.
  So how does the Map Room fit into this scenario?  Ob-
viously not big time like the examples above, but GIS
plays a legitimate role in the operation of the Map Room.
For one thing it is a tremendous help in answering the
needs of those students who need an 8.5 x 11 inch map
of the Seychelles, for example, to include in a report they
are writing.  Ever tried to find one?  Then there are the
more sophisticated needs of patrons that require not only
a map but also thematic data to go along with the map.
A most recent development in the Map Room is that soon
we will be able to post interactive maps on the Web so
that patrons can access them even from their homes.
The potential for this capability is great.  Several groups
on campus have already expressed an interest in using
it.  Definitely exciting times in the Map Room!

Hunter
Library
 Survey

by Clarissa Fisher, Administrative Librarian

■

Hunter Library will be conducting a survey in the very
near future to determine faculty perceptions of the
library’s services.  This survey will assist the library in
responding to information needs both for teaching
and research.  Faculty will be assisting the library to
adjust to change by giving this survey their timely,
thoughtful consideration.

A chance to tell us how we are doing!
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  The Friends of Hunter Library have recently concluded
their annual telephone campaign to raise funds for spe-
cial projects.  With the assistance of the University Ad-
vancement office, members of FHL were called and asked—
not just to renew their membership—but to give an ad-
ditional amount, which will be used to fund special ac-
quisitions.
  Over the past several years, the FHL has donated sev-
eral thousand dollars to the Cherokee Phoenix project
and other special projects that have made Hunter Library
a repository of a number of very special collections!  In
fact, when you have some extra time, you might want to

■

Friends of Hunter Library

PC Tip’o’ the Week!

by Robin Hitch, Computer Support Technician
with assistance from Microsoft

  Have you gotten frustrated when editing and format-
ting a document in Word 97?  If so, you are not alone.
The most common complaints heard by IS (Information
Systems) staff using Microsoft’s Office Professional is “Why
can’t I select part of a word?” and “Why won’t this pro-
gram let me format a list the way I want to?”  These
common questions can be answered with AutoFormat.
This feature of Word 97 can be very intrusive but with a
little understanding and training can be effectively pro-
ductive to your individual style.

  By default, when you are selecting a block of text in
Word, the selection block advances by a whole word at a
time as you drag the cursor over the text.  For example,
suppose you want to change “this text” to read “these
words”. When you try to highlight “is text”, so you can
type “ese words” in its place, Word selects the entire
word “this.”

  If you, like me, find this feature annoying, turn it off!
A simple option selection lets Word know you want to
select partial words.  Choose Tools | Options... click on
the Edit tab, and deselect the Automatic Word Selection
check box. Click OK to return to your document.  This will
prevent Word from Auto Selecting Whole Words.

  Maybe that feature never was a problem for you.  How-
ever, if having it automatically change words and for-
matting is what gets your blood pressure soaring, you
can change this option also. Choose Tools | AutoCorrect.
In the resulting AutoCorrect dialog box you’ll see two
tabs related to Word’s AutoFormat feature (“AutoFormat
As You Type” and “AutoFormat”).  But, it isn’t very clear
how to turn on or off all the settings of these two fea-
tures. In addition, when you select the different tabs,

AutoFormatting in Word 97

COMPUTER

7

slightly different controls
appear to indicate the
context of AutoFormatting
“in general” versus Auto
Formatting “as you type.”
This can be confusing.

  The settings that appear
when you select the
AutoFormat tab take effect
when you click AutoFormat
on the Format menu. The
settings that appear when
you select the AutoFormat
As You Type tab take ef-

fect as soon as you click OK and start typing in the docu-
ment. To disable AutoFormat As You Type, you must clear
all the settings that appear below it: On the Tools menu,
click AutoCorrect.  Select the AutoFormat As You Type
tab.  Clear (remove the check marks from) all the set-
tings under Apply As You Type, Replace As You Type and
Automatically As You Type. Click OK. This will turn off all
the AutoFormat features in Microsoft Word 97.

  Work with the different settings and select the ones
that may be helpful to you.  If you removed all the checks
and believe that the feature is off but find it still taking
control, ask the Office Assistant for more information
about why Word may still AutoFormat your document.
Click the Office Assistant, and type “Why is Word still
AutoFormatting my document?” Click Search, click
“Troubleshoot automatic formatting changes”, and then
click to view “I’ve turned off automatic formatting op-
tions, and Word is still automatically formatting my docu-
ment.” Understanding the features along with using the
Office Assistant should give you some avenues of direc-
tion to take without escalating your blood pressure to
new heights, while at the same time customizing these
features to fit your needs.

■

by Linda Gillman visit Special Collections and revisit the past!
  As those of us who are active in Friends have often
said, “we are small but mighty!”  The reality is that Friends
is a growing organization, having added a number of new
members during 1998.  FHL has also added several new
dynamic board members, who bring new energy and new
talent to the organization.  If you are one of those folks
out there who haven’t joined Friends yet; we invite you
to do so today!  Its so easy—just
make out a check to Friends of Hunter
Library for $15 (per person) and send
it to Friends, Hunter Library, WCU,
Cullowhee, NC 28723.
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New Employee
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Hunter Library
welcomes

■
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Paulina Barrier
to the position of
State Documents  Li-
brary Assistant in the
Documents Unit.
Paulina is responsible
for checking in state
depository serials
and supervising a
student assistant
who processes and
shelves state docu-
ments.  Paulina
evaluates North Caro-
lina websites making
recommendations for
new sites to include on

Next time you are in the library, take a look at what
your colleagues have had published last year.  The dis-
play case is located in front of the stairwell in the Ref-
erence area.  Publications from a wide range of depart-
ments were submitted this year for the display, which is
usually held each January-February.  It is always inter-
esting, and sometimes inspiring, to see the “finished
product” of your colleague’s research endeavors.  This
year we think that you will be impressed.

  The Reference Unit of Hunter Library has recently
added two new online history databases and a 200+
volume collection that focuses on literary biographies.
The specifics follow:

  America: History and Life — an important research
tool for those engaged in the study of North American
history or culture.  This database abstracts articles and
dissertations on the history of the U.S. and Canada as
well as articles that consider our current culture.  This
title also provides indexing to reviews of books, vid-
eos, films, and non-print media.  Over 2200 serial pub-
lications are indexed, from 1964 to the present.

  Historical Abstracts — for those involved in history
research outside of North America, this is one of the
standard research tools.  Selectively indexes over 2200
journals as well as dissertations and books.  Covers
world history from 1450 to the present; indexing be-
gins in 1954.

Reference Adds
 New Resources

by Roger Stelk,
Director of Public Services

the unit’s web page.  She will also be working with the
Marcive Serials Backfile project.
  Paulina is from Freetown, Sierra leone, where she ob-
tained a Higher Teachers Certificate (H.T.C.) at Milton
Margai Teachers College in Goderrich, Sierra Leone.  She
is currently working towards the A.A.S. degree in ac-
counting at SCC.  Paulina resides in Cullowhee with her
husband Danny, a Police Officer at WCU, and her 7 month
old daughter, Nyla.

  Both of the above titles are available by selecting
Online Resources from the Hunter Library homepage.
America: History and Life allows up to six simultaneous
users.  The Historical Abstracts licensing agreement only
allows for one user at a time.

  Finally, more than 200 volumes of the Dictionary of
Literary Biography have been added to the Reference
collection.  Each volume
of this set consists of col-
lected essays devoted to
a single type, genre, geo-
graphic area or time pe-
riod.  The essays gener-
ally combine biographical
and critical aspects of the
author and his or her
work.  Emphasis is also
given to the writer’s his-
torical importance and
influence.
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Extended Hours
Sunday, January 31 to Thursday, March 4

SPRING BREAK
Friday March  5  8:00 a.m. to 6:00 p.m
Sat. & Sun. March  6 & 7   CLOSED
Monday, March  8 to
  Friday, March 12  8:00 a.m. to 5:00 p.m.

Saturday March 13   CLOSED

Sunday March 14  4:00 p.m. - Midnight

Extended Hours
Monday, March 15 to Wednesday, March 31

EASTER BREAK
Thursday April  1  8:00 a.m. to 10:00 p.m.
Friday, April  2  CLOSED

Saturday, April  3 10:00 a.m. to  6:00 p.m.
Sunday, April  4  4:00 p.m. - Midnight

Extended Hours
Monday, April  5 to Friday, May 7

HUNTER LIBRARY HOURS
Spring 1999

Extended
Hours

Monday through
Thursday

8:00a.m.-2:00a.m.

Friday
8:00a.m.-9:00p.m.

Saturday
10:00 a.m. - 6:00 p.m.

Sunday
Noon - 2:00 a.m.


